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Setting Logging Levels Before You Create a Problem Report
By default, when you start Cisco Unified Communications for RTX (Cisco UC for RTX) and Client 
Services Framework, the logging level is set to Reduced. 

If you want to report a problem with Cisco UC for RTX, you must set the logging level in Cisco UC for 
RTX to Verbose before you create the problem report. To set the logging level, select File > Cisco UC 
Settings > General. Select Verbose as the logging level, then select OK.

To obtain logs for Cisco UC for RTX from a user, ask the user to create a problem report and send the 
report to you. For information about how to create a problem report, see the FAQ help or the user 
documentation for Cisco UC for RTX at the following URL:

http://www.cisco.com/en/US/products/ps11241/tsd_products_support_series_home.html

Alternatively, you can view the log files in the following locations:
5-1
 Cisco Unified Communications for RTX Release 8.5

http://www.cisco.com/en/US/products/ps11241/tsd_products_support_series_home.html


 

Chapter 5      Troubleshooting Cisco Unified Communications for RTX
Moving a Device to Another Cluster
Moving a Device to Another Cluster
If you configure security in your Cisco Unified Communications system, you use Certificate Trust List 
(CTL) files. The CTL file contains certificates for all of the servers in your 
Cisco Unified Communications system with which Client Services Framework might need to 
communicate securely.

When a device connects to a server in your Cisco Unified Communications system, the server is verified 
against this list. Client Services Framework does not allow secure connections to servers that are not 
explicitly listed in the CTL.

If a device is moved from one cluster to another, you must update the CTL file for the device list of 
servers in the new cluster. 

Procedure

Step 1 Delete the contents of the appropriate folder as described in the following table:

Step 2 Delete the contents of the appropriate folder as described in the following table:

Operating System Log File Location

Windows XP <drive>:\Documents and Settings\<username>\Local 
Settings\Application Data\Cisco\Unified Communications\Cucrtx\Logs

<drive>:\Documents and Settings\<username>\Local 
Settings\Application Data\Cisco\Unified Communications\CUCIPlugin

<drive>:\Documents and Settings\<username>\Local 
Settings\Application Data\Cisco\Unified Communications\Client 
Services Framework

Windows Vista
Windows 7

<drive>:\Users\<username>\AppData\Local\Cisco\Unified 
Communications\Cucrtx\Logs

<drive>:\Users\<username>\AppData\Local\Cisco\Unified 
Communications\CUCIPlugin

<drive>:\Users\<username>\AppData\Local\Cisco\Unified 
Communications\Client Services Framework

Operating System Folder

Windows XP <drive>:\Documents and Settings\<username>\Application 
Data\Cisco\Unified Communications\Client Services 
Framework\Security\sec

Windows Vista
Windows 7

<drive>:\Users\<username>\AppData\Roaming\Cisco\Unified 
Communications\Client Services Framework\Security\sec
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Step 3 Update the device settings for the user to point to the new cluster. For example, update the references to 
the Cisco Unified Communications Manager IP Phone (CCMCIP) server, Trivial File Transfer Protocol 
(TFTP) server, and Computer Telephony Integration (CTI) servers.

How to Resolve General Problems with Cisco UC for RTX
• Cisco UC for RTX Is Slow To Start, page 5-3

• Cisco Unified IP Phone 7931G Users Cannot Control Desk Phone from Cisco UC for RTX, 
page 5-4

• Cisco UC for RTX Fails To Start, page 5-4

• Cisco UC Features Unavailable If Host Name Resolution Fails, page 5-5

• Incorrect Caller Name Displayed for Shared Lines, page 5-5

• CAST Connection from Cisco Unified IP Phone Times Out, page 5-6

• Users Lose Control of the Active Call on the Desk Phone, page 5-6

• Users Cannot See the Participant List for the Conference Call, page 5-6

• Users Can Only Control One Line on Phones Configured for Multiple Lines, page 5-6

• Cannot See All Calls in Progress on Cisco Unified IP Phone 9900, 8900, and 6900 Model Series, 
page 5-7

• How to Resolve Synchronization Problems, page 5-7

• How to Resolve Availability Status Problems, page 5-7

• How to Resolve Voicemail Problems, page 5-8

• Error Connecting to the CSF Device, page 5-8

Cisco UC for RTX Is Slow To Start

Problem When users start Cisco UC for RTX, more than a minute might pass before the Cisco UC user 
interface components are displayed. This occurs when the user cannot create an SSL connection to 
Verisign, the Digital Signature Certificate Authority for Cisco. This problem typically occurs if the user 
is in an organization that uses web proxies, content filtering, or strict web access controls. 

By default, .NET Framework applications validate the certificate of the publisher before the user 
interface is displayed. The application creates an SSL connection to Verisign. If the application cannot 
connect to Verisign, the standard HTTP timeout of 60 seconds occurs. After this timeout, the application 
starts and validation of the certificate is deferred.

Operating System Folder

Windows XP <drive>:\Documents and Settings\<username>\Application 
Data\Cisco\Unified Communications\Client Services Framework\Config

Windows Vista
Windows 7

<drive>:\Users\<username>\AppData\Roaming\Cisco\Unified 
Communications\Client Services Framework\Config
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Solution Open the Internet Options item in your Control Panel. Select the Advanced tab, and uncheck 
Check for publisher's certificate revocation in the Security section.

Cisco Unified IP Phone 7931G Users Cannot Control Desk Phone from 
Cisco UC for RTX

Problem Users who have a Cisco Unified IP Phone 7931G cannot use their desk phone from 
Cisco UC for RTX.

Solution Set the value of the Outbound Call Rollover field to No Rollover in Cisco Unified 
Communications Manager, as follows:

Step 1 Select Device > Phone in Cisco Unified Communications Manager Administration.

Step 2 Search for the Cisco Unified IP Phone 7931G phone of the user in the Find and List Phones window.

Step 3 Select the Cisco Unified IP Phone 7931G phone.

Step 4 Select No Rollover from the Outbound Call Rollover list box in the Protocol Specific Information 
section.

Step 5 Select Save.

Cisco UC for RTX Fails To Start

Problem Cisco UC for RTX fails to start. Warnings are displayed for some of the failures.

Solution Host Intrusion Protection Software (HIPS) software might unexpectedly terminate the 
cucrtx.exe process. Start the Task Manager, then check if the cucrtx.exe process is running. If the process 
is not running, check if there is HIPS software running on your computer. Disabling HIPS software 
might help to resolve this problem. For information about HIPS software updates that might resolve this 
issue, please contact your HIPS vendor.

The exact cause of the process termination is not clear. Please report such incidents to Cisco support to 
help to determine the root cause of the problem and to help identify a solution.

Table 5-1 lists warning messages that are displayed for other loading failures.
5-4
Installation Guide for Cisco Unified Communications for RTX Release 8.5

OL-23530-02



 

Chapter 5      Troubleshooting Cisco Unified Communications for RTX
How to Resolve General Problems with Cisco UC for RTX
Cisco UC Features Unavailable If Host Name Resolution Fails

Problem After a successful sign-in to Cisco UC for RTX, the user cannot use Cisco UC features.

Solution This failure is typically due to the inability of the client computer to connect to a domain 
controller. This can be caused by name resolution failure. The DNS server of the client computer is not 
available, or is not configured correctly, and the client computer cannot find a domain controller.

If the cause of failure is resolved, sign out of RTX, then sign in to it again. Alternatively, restart RTX.

Incorrect Caller Name Displayed for Shared Lines

Problem When users are configured in Cisco Unified Communications Manager to share a line, the 
incorrect caller name might be displayed in notification windows or in the conversations window.

Solution This is expected behavior. In Cisco Unified Communications Manager, caller names are sent to 
the phones when the phones are initially configured. However, Cisco UC for RTX must search for the 
caller name in RTX contact information. 

If lines are shared, when Cisco UC for RTX performs a search based on the phone number, the caller 
name in the first set of results returned that is the closest match to the Cisco Unified 
Communications Manager caller name is displayed. When shared lines are not configured, there is 
usually only one match in RTX contact information for the phone number and the caller name associated 
with this number is displayed.

Table 5-1 Failures and Solutions

Warning Message Solution

Failed to start Cisco UC for RTX. Perform each of the following steps until Cisco UC for RTX is 
successfully loaded.

1. Exit RTX and start it again.

2. Restart the computer.

3. Reinstall Cisco UC for RTX.

4. Create problem report. To do this, select Help > Cisco UC > 
Create Problem Report.

Cisco UC for RTX exited 
unexpectedly.

See above.

Registry subkeys of Cisco UC for 
RTX do not exist.

For mass deployment, ensure that the registry settings that you 
deployed to the client computers of your end users are correct.

For standalone installation, ensure that the template file of 
registry settings on RTX server is correct.

Registry subkeys of Cisco UC for 
RTX cannot be added or modified.

See above.
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CAST Connection from Cisco Unified IP Phone Times Out

Problem When attempting to start a Cisco Audio Session Tunnel (CAST) connection from a Cisco 
Unified IP Phone, the connection times out. 

Solution To resolve this issue, check to ensure that:

• The Cisco Unified IP Phone is configured as an SCCP phone in Cisco Unified 
Communications Manager.

• The Cisco Unified IP Phone is enabled for video capabilities in Cisco Unified 
Communications Manager.

• The following ports are enabled in Cisco Unified Communications Manager:

– Cisco Discovery Protocol (CDP): Switch Port

– Cisco Discovery Protocol (CDP): PC Port

• The video icon is displayed in the lower right corner of the LCD screen on the Cisco Unified IP 
Phone.

• The client computer that is running Cisco UC for RTX is tethered to the Cisco Unified IP Phone.

• Cisco Unified Video Advantage is not running. Cisco Unified Video Advantage should not be 
running, see Removing Applications Before Installation, page 4-1 for more information.

For more information about how to perform the checks outlined above, see Configuring Failover to Cisco 
Unified Survivable Remote Site Telephony (SRST), page 2-14. 

Users Lose Control of the Active Call on the Desk Phone

Problem A user can no longer control the active call on the desk phone.

Solution If a user docks, undocks, hibernates, resumes, or suspends the computer while a call is in 
progress on the desk phone, the call remains active, but the user cannot control the call from the 
computer. This is expected behavior.

Users Cannot See the Participant List for the Conference Call

Problem If users have a conference call that involves users in different clusters, some users might not be 
able to see the participant list for the conference call. Instead, the conference call resembles a call 
between two users.

Solution This is expected behavior.

Users Can Only Control One Line on Phones Configured for Multiple Lines

Problem Cisco UC for RTX can only control one call session button on a phone that is configured for 
multiple lines.

Solution Cisco UC for RTX can control the first line in the list of lines returned by the Cisco Unified 
Communications Manager CTI service. You cannot change which line is controlled when the lines are 
partitioned. You can change which line is controlled by Cisco UC for RTX if the lines are not partitioned, 
that is, they have different directory numbers. 
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Cannot See All Calls in Progress on Cisco Unified IP Phone 9900, 8900, and 6900 
Model Series

Problem Cisco UC for RTX monitors only one call session button on the desk phone that is associated 
with it. The Cisco Unified IP Phone 9900, 8900, and 6900 model series allow simultaneous calls on 
multiple call session buttons. Any call operations that happen on buttons other than the one that 
Cisco UC for RTX monitors are not reflected in the Cisco UC for RTX user interface.

If you place or answer a call on a call session button that is not the one that Cisco UC for RTX monitors, 
the call does not appear in Cisco UC for RTX as an active call.

Solution You cannot use Cisco UC for RTX to control calls on the buttons that Cisco UC for RTX does 
not monitor.

The impact of Join Across Line (JAL) and Direct Transfer Across Line (DTAL) operations on a call that 
Cisco UC for RTX controls depends on whether the operation moves a call to a monitored call session 
button.

If a JAL operation moves a call to a monitored call session button, the call transitions to a conference 
call. If a JAL operation moves a call to an unmonitored button, the call disappears from the Cisco UC 
for RTX user interface. Cisco UC for RTX cannot control the call.

Similarly, a DTAL operation moves a call to a monitored call session button, Cisco UC for RTX can 
control the call, but if the call moves to an unmonitored button, Cisco UC for RTX cannot control the 
call.

How to Resolve Synchronization Problems

Problem A contact updates the office or the mobile phone number in the personal settings of RTX. When 
other users make calls to the contact, Cisco UC for RTX may still use the outdated phone numbers for 
phone calls.

Solution This is the expected behavior. The RTX client synchronizes the local contact information when 
any of the following events occur:

• A user moves the mouse over a contact in the contact list, and the contact information window 
appears.

• A user starts an IM chat with a contact.

• A user views the contact card of a contact.

To resolve this issue, ask the user to perform one of these actions, then restart RTX.

How to Resolve Availability Status Problems

Problem Users might observe some unusual availability statuses.

Solution This is expected behavior. RTX provides the availability information in Cisco UC for RTX. In 
particular circumstances, Cisco UC for RTX provides custom phone availability status information 
which can result in unusual availability statuses. 

The following table lists the circumstances that result in these unusual availability statuses:
5-7
Installation Guide for Cisco Unified Communications for RTX Release 8.5

OL-23530-02



 

Chapter 5      Troubleshooting Cisco Unified Communications for RTX
How to Resolve General Problems with Cisco UC for RTX
RTX can set your availability to away or offline when the system detects no mouse or keyboard actions 
within a certain period. You can enable or disable this feature in the personal settings of RTX.

How to Resolve Voicemail Problems

Problem If users are using desk phone for phone calls, they cannot access their voicemail service on 
Cisco UC for RTX.

Solution When you set Cisco UC for RTX to use your desk phone for phone calls, you must configure 
the voicemail pilot number registry subkey, VoicemailPilotNumber. For more information, see the 
“Specifying Voicemail Registry Settings” section on page 3-4.

Error Connecting to the CSF Device

Problem When Cisco UC for RTX tries to connect to the Client Services Framework (CSF) device on 
Cisco Unified Communications Manager after an upgrade, the user sees the error "CTL reset is required 
[1002]" and the phone on the computer does not function.

Solution If you configure security in your Cisco Unified Communications system, you use Certificate 
Trust List (CTL) files. The CTL file contains certificates for all of the servers in your Cisco Unified 
Communications system with which Client Services Framework might need to communicate securely.

When a device connects to a server in your Cisco Unified Communications system, the server is verified 
against this list. Client Services Framework does not allow secure connections to servers that are not 
explicitly listed in the CTL.

If a device is moved from one cluster to another or you upgrade to a new version of Cisco Unified 
Communications Manager, you must update the CTL file for the device list of servers in the new cluster.

Procedure

Step 1 Delete the contents of the appropriate folder as described in the following table:

Initial Availability Status Event Availability Status Is Updated To...

Away Call starts Away

When a call starts, your availability does not 
change if you are away.

On the phone Call starts On the phone

When a call starts, your availability does not 
change if you are on the phone.

Away All calls end Away

When all calls end, your availability does not 
change if you are away.
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Step 2 Delete the contents of the appropriate folder as described in the following table:

Step 3 Update the device settings for the user to point to the new cluster. For example, update the references to 
the Cisco Unified Communications Manager IP Phone (CCMCIP) server, Trivial File Transfer Protocol 
(TFTP) server, and Computer Telephony Integration (CTI) servers.

How to Resolve Video Problems
• Users Cannot Use Video Features on Their Computers When They Use Their Desk Phone, page 5-9

• Users Cannot See Video in Ad-Hoc Conference Calls, page 5-10

For more information about video problems, see the release notes for the product at the following URL:

http://www.cisco.com/en/US/products/ps11241/prod_release_notes_list.html

Users Cannot Use Video Features on Their Computers When They Use Their 
Desk Phone

Problem When users have selected to use their desk phone for phone calls, they might not be able to use 
video on their calls, even when the phone is configured for video. A warning icon appears in the status 
bar on the RTX main panel. If a user selects Help > Cisco UC > Server Status and Error Notifications, 
the following error is displayed in the Server Status tab as the value of the Status field in the Desk Phone 
(CAST) entry:

“CSF can't detect phone - no phone attached.”

Solution To resolve this problem, check the following, in the order shown below:

1. The camera or built-in camera is functioning correctly. Check that the camera is attached correctly 
to the computer.

2. The computer is tethered to the desk phone.

Operating System Folder

Windows XP <drive>:\Documents and Settings\<username>\Application 
Data\Cisco\Unified Communications\Client Services 
Framework\Security\sec

Windows Vista

Windows 7

<drive>:\Users\<username>\AppData\Roaming\Cisco\Unified 
Communications\Client Services Framework\Security\sec

Operating System Folder

Windows XP <drive>:\Documents and Settings\<username>\Application 
Data\Cisco\Unified Communications\Client Services Framework\Config

Windows Vista

Windows 7

<drive>:\Users\<username>\AppData\Roaming\Cisco\Unified 
Communications\Client Services Framework\Config
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3. The desk phone is running SCCP firmware. SIP firmware does not support video when Cisco UC for 
RTX is set to use the desk phone for phone calls.

4. The operating system of your computer is not Microsoft Windows 7 (64-bit).

5. In Cisco Unified Communications Manager Administration, ensure that the Video Capabilities 
option is set to Enabled for the desk phone.

6. Symantec Endpoint Protection might be blocking the addresses used by Cisco Discovery Protocol 
(CDP). To resolve this problem, create a rule in Symantec Network Threat Protection (NTP) to allow 
the following MAC addresses:

01-00-0c-cc-cc-cc 

01-00-0c-cc-cc-cd

For more information about how to create this rule, see the following URL:

http://service1.symantec.com/SUPPORT/ent-security.nsf/docid/2008062616331948

Users Cannot See Video in Ad-Hoc Conference Calls

Problem Users cannot see video in an ad-hoc conference call.

Solution This could be as a result of either of the following settings:

• Minimum Video Capable Participants To Allocate Video Conference setting in Cisco Unified 
Communications Manager

• Media Resource Configuration setting in Cisco Unified MeetingPlace Application Server.

Related Topics

• (Optional) Specifying a Minimum Number of Video-Capable Participants for Ad-Hoc Conferences, 
page 2-11

• Configuring a Cisco Unified MeetingPlace Application Server for Ad-Hoc Video Conferencing, 
page 2-15

How to Resolve Camera Problems
• Camera Troubleshooting Tips, page 5-10

• Some Cameras Zoom In Suddenly During a Call, page 5-11

For more information about video problems, see the release notes for the product at the following URL:

http://www.cisco.com/en/US/products/ps11241/prod_release_notes_list.html

Camera Troubleshooting Tips
The following are some general tips to avoid camera issues:

• Ensure that you have installed the correct driver for your camera.

• To configure the camera that you want to use with Cisco UC for RTX, select Actions > Audio/Video 
> Audio/Video setting in the RTX main panel. The tool allows you to preview the video output from 
the camera.
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Some Cameras Zoom In Suddenly During a Call

Problem During a call, the camera sometimes zooms in suddenly. This problem may occur on cameras 
that support the autofocus feature, as the camera tries to regain focus of the image.

Solution Place the call on hold and resume the call to see if the image is restored correctly.
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